GJC Web Design Virtuemart 3.0 J3
Product Review Package v2.1.3

The VirtueMart Reviews Component

Amazon style reviews for your Virtuiematt shop
Reviews linked to purchases & products

1 hambart

WEBDESIGN

Installs as a native Joomla Package. You can download it here - Download
Price is €50.00 Test Site Here GJC Web Design Product Review

Description

The package is designed to provide an 'Amazon' like product review. From version 2.1.00 it is now
possible for Guest Shoppers & Public to be incl. in the system and invited to leave reviews. The
Admin can of course add new reviews and moderate/edit existing reviews. Rich Snippets are also
incl. for the product detail reviews.

Full SEF routing is provided and Amazon style useful ratings are included.

From release 2.0.2 correctly groups and handles parent/child reviews into one overview of the
reviews. Ratings are now displayed in product details with a small override snippet.

Code is provided for also showing ratings in the VM Modules.

There is also now an importer for the old VM Reviews.

Includes German and Italian translations.

Incorporates the latest Google required Structured data in JSON form. The native VM snippets
sublayout is not required.

This package handles "one off" products as it stores each purchased products details and user
information to a separate component which the administrator has full control over. Even if the
product is later deleted from VM there record is still kept along with the image in the VMReview
component.

The reviews can be shown on each product by a simple template over ride.

It can also be set up to send review reminder emails to the purchaser after a set period of time by
running a script through Joomladdons.eu clever Zoombie Plugin. There is now an importer to import
all your current orders into the component. The Zoombie plugin can then be set to send an email
(plain text or html) to each client asking for a review.


http://www.gjcwebdesign.com/vm2-product-review.html
http://www.gjcwebdesign.com/vm2t7/

From version 2.1.1 there is a function for recipients to opt out of receiving emails via a link in the
email.

The Zoombie Plugin is now included in the zip.

This is a 3rd party extension and therefore is NOT supported by GJC Web Design!

Step 1: Install GJC VMReview package
After downloading the package unzip it. Then unzip VM.3.0_J3.VMReview.2.1.2_UNZIP_1st.zip.

virtuemart_template_over_rides_VM3
GJC_VMReview Virtuemart_3_13.pdf
(1] VM.3.0_)3_VMReview_2.1.2.zip

Use the standard Joomla Installer to install the zip file VM.3.0_J3.VMReview.2.1.2.zip.

IMPORTANT: the component language files are now moved to the language folder of the component

as per the new Joomla recommendations .

If you are upgrading then you must delete the old en-GB.com_vmreview.ini & en-
GB.com_vmreview.sys.ini etc in the old /language/en-GB path in the frontend and admin. If you
have made translations please combine them with the new lanaguage ini.

The zoombie_vmreviews plugin has also been done so also delete the en-
GB.plg_zoombie_vmreview.ini & en-GB.plg_zoombie_vmreview.sys.ini from the admin language

folders

This will install the component, a module and 5 plugins.

Message
Installing package was successful.

VirtueMart 3 - Joomla 3 - VMReview Package

Upload Package File Install from Directory Install from URL

Inside the ' virtuemart_template_over_rides ' folder is the 'html' folder containing the necessary VM
template over rides. Copy the complete 'html' folder to templates/{YOUR_TEMPLATE}/

If you already have over rides of the same name in this folder you will need to combine the
changes - or contact me.

If you don't require that the appropriate reviews display on the product pages just delete the
default.php file. If you do require this then read further on page 12 how to enable.

This also applies to the ratings. This again is displayed by a small over ride template
default_gjcshowrating.php.

This can replace any current ratings display code in your template .. see also page 12.
The same technique can be used to show ratings in modules etc by some copy/paste code.



SEF urls for the reviews

Menu items to the core VMReviews component are required for the SEF urls.

If your site is a single language just make a menu as in Step 7 .. this can also be a hidden menu.
If multi-lingual make the same type of menu in each required language and set these menus
language correctly.

The menu alias will be the first segment in your SEF reviews url:

e.g.

/en/reviews/article-reviews/classic-hat/stars-5

/ de/rezension/produkte-rezension/klassic-hut/stars-5

The next segment is (/article-reviews/ ) is set by the language constant
VMCUSTOM_SHOWREVIEWS_SEO_VIEW="article-reviews"

This is required in all languages in both:

components\com_vmreview\language\en-GB\en-GB.com_vmreview.ini
plugins\vmcustom\showreviews\language\en-GB\en-GB.plg_vmcustom_showreviews.ini
etc

The 3rd segment ( /classic-hat/ ) is automatically retrieved from the Virtuemart product alias
The 4th segment (/stars-5/ ) is again set by a language constant

VMCUSTOM_SHOWREVIEWS_SEO_STARS="stars"

again required in all languages in both:

components\com_vmreview\language\en-GB\en-GB.com_vmreview.ini
plugins\vmcustom\showreviews\language\en-GB\en-GB.plg_vmcustom_showreviews.ini
etc

Step3: Configure and enable the plugins
In Joomla Admin ->Extensions->Plug-in Manager search for 'review' and enable the three plugins
Virtuemart - VMReview, VM Custom - Show Reviews & Zoombie - VMReview

® | Edit « | Enable @ | Dizable b | Check-n

review Q Search Tools = Clear

= Status  Plugin Mames

il VirtueMart - Ajax VMReview
e WirtueMart - WkReview

e WM Custom - Show Reviews
o Zoombie - Vmnreview

Open each of the plugins and configure.



VirtueMart - Ajax VMReview
The VirtueMart - Ajax VMReview enables the posting of the reviews from the forms plus the
"helpful" ratings etc.

It must be enabled.

Virtuemart - VMReview plugin

The Virtuemart - VMReview plugin configures who and how the reviews are submitted and what is
shown on the clients Account page. It can be configured to automatically publish reviews (or have
them moderated), max & min lengths required, number of stars for the rating, send an email to the
Admin when a review is submitted and the names to show.

Whether Captcha is shown on the public pages is controlled here but if enabled it must be correctly
configured and enables in Joomla. Both v2 & v3 are possible.

It is also responsible for loading the JS and CSS assets etc

It must be enabled.

& Plugins: VirtueMart - VMReview ' Joomlar
& save + | Save & Close @ | Close @ | Help
Message
Plugin saved
Plugin
VirtueMart - VMRevi —
IrtueMart - eview
Virtueltart
VirtueMart - VMReview system plugin - Needs the GJC VMReview 2.1.x Component Access
Public =
Who can review The public from product detai... ~ Ordering
0. System - JCE -
Use Captcha? No
® Yes Plugin Type
system
Currency Symbol = €
Plugin File
Maximum number of stars * 5 .
vmreview
Maximum length of review * 2000
Minimum length of review * 100
Send mail No
® Yes l%
Auto approve? ® Mo

VM Custom - Show Reviews Plugin
The VM Custom - Show Reviews is used to show the appropriate review on the Virtuemart product
page. It can be configured for minimum rating to show, how many, and many other parameters.

You can add a heading in the pretext (accepts html)



WM Custom - Show Reviews

CTE
T/

WM Custoem plugin o Show thie revws Tom the GIC Product Resews COMponent In 3 product page Arcess
Pulsic
Mirirmusn RS 1 Drdering
L VM CLstem - Customer lee..
How many fo shaow 3
Flugin Type
Dordr vy Randam T L
Show rarne ® Vs g Fibe
o shewraviens
Show real names? ® Yes
ha
Show reviewers ity  Tes
Mo
Show PIOSUCE CountTy # Yo
Na
Show fokals " Yes

Mo

Zoombie - System Plugin

Configure as follows:

& Plugins: System - Alikonweb Zoombie
m v | Save & Close & | Close

Plugin

System - Alikonweb Zoombie
 srstem B coomibe |

Zoombie Plugin to run WM Reviews reminders

Mode Setting

1. Cron: setup a standard cron job in your web server cPanel to run this script every 12 hours.

The path will be something like Yusrlocal/bin/php -f fhomef{usemame)public_htmlcli'cli2Zzoombie. php'.
Consult your host.

2. Webcron: this script will be triggered by any requests { page activity ) on the front end of your website. this is the recommended mode.

3. For testing consult the handbook and plugin 'Zoombie - Vmreview'.

Task Starter Engine () Gron
@ Webeoron
Schedule 1 min -
LET] () Mo
® “es
Attach W Mo
[

You can enable the email for a short period to check that it is firing - the admin email address will
receive an email each minute but remember there has to be some frontend activity to trigger it (just




click around somewhere on your site or use the site menu). The Zoombie plugin can be set to run
every 12 hours to check if any reminder emails need to be sent.

The Webcron is triggered by Frontend activity... so if testing you must browse the frontend to trigger
the Webcron.

If you have some problems with the Webcron you can try a normal Cron and trigger via your cPanel
etc.
The path is something like /usr/local/bin/php -f /nome/(username)/public_html/cli/cli2zoombie.php

It appears the Alikon Zoombie site is now dead... Please note that ALL the Zoombie code is originally
from this developer and therefore | can only offer minimal support.. the settings mentioned all work
on the majority of standard web server setups.

Zoombie - VMReview Plugin

The Zoombie - VMReview has a setting for the number of days to wait before sending a reminder
email from a configurable Status, when to repeat, whether the email is plain text or html and the
html email editor. You can disable the email to the Admin and set the maximum number of emails
per trigger. This should be set especially after an import of existing orders to around 200-300 per
trigger.

There is also a debug setting for testing and to display debug messages .

For multilingual sites it is recommended to use the lang constant
VMCUSTOM_REVIEW_HTMLEMAIL_DEFAULT

in the Html Email text field and use/edit this lang constant in your language ini
administrator\language\en-GB\en-GB.plg_zoombie_vmreview.ini etc

The language constant for the optout link is {optoutlink}

An example email is

VMCUSTOM_REVIEW_HTMLEMAIL_DEFAULT="Dear {name},<br /><br />0n the {date} you bought
our {product}<br /><br />If you are satisfied with this product we would be delighted if you would
leave a review on our site.<br /><br />If registered simply login and browse to 'Your Account' where
you will be able to submit your review.<br /><br />If you purchased as a guest then click the link
below.<br />{link}<br /><br />If you wish to opt out from these reminders then click the link
below.<br />{optoutlink}<br /><br /><br />Yours faithfully,<br /> {site}"

VMCUSTOM_REVIEWS_LINK="Leave A Review"
VMCUSTOM_REVIEWS_ OPTOUTLINK="Opt out from these reminders"
VMCUSTOM_REVIEWS_SUBJECT="Reminder from "

Sadly there appears to be a bug in Joomla when the lang is programmatically set; any over rides
configured by the standard Joomla lang over rides system are ignored. This means the changes must
be made in the ini files - also keep backups of these as they will be over written if the extension is
upgraded and will need to be re-inserted.



& Plugins: Zoombie - Vmreview

T Joomlal

+ | Save & Close 9 | Clos= @ | Ha=p
Plugin Basiz
Testing the email reminder system
1. On this plugin set the 'Debug’ on Yes.
2. On this plugin set the On 'Debug send mail' on Yes if you want to send the actual emails.
3. Fillin a test VM Order ID : N.B. NOT the Order Number!!
4. Fillin the email address you want the test sent to.
5. Click the test bution
6. The full debug will be visible in a new window and emails will be sent if chosen and the Admin will receive an email.
Status to send reminder c
How often to check 5 min -
First reminder 1day -
Fesend reminder Sdays -
Maximum reminders T -
Html emai () Me
® es
Ftmi Bmail texd 0] Editer = Code Praview
8 [ B I U & E E E = @ Fomat w Styles v ¥ ¥
Font family v Fontsize rfAalx|ZivX BB B2 = = A & v A
0 & 8 &~
T s || [ = RICE I B =R == |
VMCUSTOM_REVIEW_HTMLEMAIL_DEFAULT
WMCUSTOM_REVIEW_HTMLEMAIL_DEFAULT
Path: Words: 1 4
[} Module B Menu B cContact L3 Adicle & Image
Send Admin email (O Mo
® Yes
Mumber of emails 300
Debug () Me
® Yes
On Debug send mail () Ne
® Yes
Debug 2 single order ped=]

Debug = single order email tesiZ@gjcwebdesign.com

Test your emzil:




Testing the reminder sending
You can manually test your manual setups by running the scripts from your browser :

1. On plugin ' Zoombie - Vmreview ' set the 'Debug' on Yes.

2. On plugin ' Zoombie - Vmreview ' set the On 'Debug send mail' on Yes if you want to send the
actual emails.

3. Fill in a test VM Order ID : N.B. NOT the Order Number!!

4. Fill in the email address you want the test sent to.

5. Save the plugin!

6. Click the test button

7. The full debug will be visible and emails will be sent if chosen and the Admin will receive an email.

8. When finished set the debug back to No and save the plugin.

You will feedback printed on the screen and the emails will go to the chosen email address IF you
have selected On Debug send emails

It is also possible to test the cron scripts by setting the Debug ON in Plugins: System - Alikonweb
Zoombie and Saving the plugin.

Then set your Cron to run every minute and you will receive the emails for the order and email set in
the Plugins: Zoombie - Vmreview plugin.

It is also possible to run the CLI script by using the url:

https://YOUR-Site.com /cli/cron2zoombie.php?bypass=1

Order Save for VirtueMart
Search for 'order' in Joomla Admin ->Extensions->Plug-in Manager to find the order save plugin.

This plugin saves any confirmed purchased items to the VMReview component when they are
updated to the "Chosen" Status.
You can also choose to allow un registered shoppers orders to be saved.

# Plugins ¥ Joomlar
B  Edit ~ | Enable @  Disable bl | Check-in @  Hep g Options
order Q Search Tools » Clear Type ascending - 25 | -

s Status  Plugin Name Type~ Element Access ID

v Order Save for VirtueMart vmecustom ordersave Public 10063




& Plugins: Order Save for VirtueMart 7t Joomilal’

+ | Save & Close @ | Close @ | Hepp
Plugin
. Status
Order Save for VirtueMart
Enabled -
[ vmeustom [
Virtuemart Plugin to save order details incl. images for each order. Needs the GJC VMReview 3.0.0 compenent Access
Public =
Status to save products C Ordering
0. GJC Any Price Custom Plu... =
Allow non-registered users No
® Yes Plugin Type
vmcustom
Name to show ® First Name
Full Name Plugin File
ordersave
Product image handling Mo change
# Copy - original remains
Move - original deleted
Image folder Imediafordersave/
Switch on Debug ® No
Yes

You can set when to save the individual purchased products by their VM Status - e.g. Confirmed (C)
or Shipped (S) etc.

You can also set the image handling .. do nothing, Copy the image to a preset folder or Move the
image (i.e. delete the original from VM - useful if you have one off items ) & if full or firstname is
saved. There is also a debug option: this will "fail" the final save but print out all the info so you can
check if everything is working.

Step4: Testing the Ordersave plugin

In Joomla Admin ->Components->Virtuemart and click on Orders.

It is simpler to first make yourself a test order in your shop. Find this order and set it's Status to what
you have set in the plugin (C or S etc).

+ Update Order stit\u; X Delste

g Please Select =
3 Go || Reset H
Vﬁjenﬁart \ iz s eset. | Ordar Status:
Results 1-4 of 4

Order Payment

W ORDERS & SHOPPERS number Name Email Method  Print View Order Date ~ Last Modified Status
Orders @ 4ef606  Test  testi@giowebdesign.com  Cash on {u{ ﬂ' + Tuesdzy, 17 March  Tuesday, 17 March | Confirmad -
One delivery T - 2015 16:53 2015 16:53

Add Comment

Revenue Report

When you update this Status the message will come back:

+" Update Order Status X Delete

Notice
Order saved to GIC Reviews table

Message
1 order(s) have been updated




In Joomla Admin ->Components->VM Review you will see your first saved order!
You need to also configure via the top right "Options" button various parameters for the display of
the reviews and very importantly whether the Parent/Child reviews are bundled.

VM Reviews List HH ! Joomlal

m @ | Edit + | Publish €@  Unpublish W Trash ] Opéijuns
VM Reviews List Filter: Q X | 25 v  -Selec Status- v

VM Reviews
Importer

Vmreview Configuration A4 Joomilal’
& Save + | Save & Close @ | cancel @ | Hepp
SYSTEM VM Review Permissions
Global

Configuration
@ Component for reviews linked to Virtuemart purchases

COMPONENT
Articles Order by Rating -
Banners
Cache Order Direction Agzcending -
Check-in
Contacts How many to show 10
Installer
JCE Editor Pro Itemid of VM Home Page %
Joomla! Update
Languages Combine Parent & Child @ No
- reviews Yes
Media

WM Reviews: Lt ' ol
Ty p—
Vitmewrt  Croe - b o b T At
Codar ure ] e == Fosners Oy cuky  Frosked Rams Raeg Hephd Remide Feese Das s Fabisbad 1D
&1 [ e T | Beby  Uraed Claamic a a B -] -] -] o
.
. T A e b g emtaripies Fl s Uil -] -] -] o
[
i b gt Pl - [ T T o -] -] -] o
st i
(=) bl Bt Frad [ e S o o o &
e
13 [ ar Bgoandengoom Frad Fagrams  Unfed Claamsr st 5 - o - [-] -
Hates
1003 a1 b egcemtdaigruon Frad Fagrems  Untsd Clamic st 3 o -] -] -] o
¥ POUNT A1 e e gcemtsigron  Frad Fagrems  Lintsdd Clasc st 2 o -] o a v
e
A e B | e Lnaed Clasmc st [ & -] o -] -
e
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T
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Remember - individual products from each order are saved so the User has the opportunity to review
each product separately.

The individual reviews can be opened and edited, new entries can be made and entries can be
deleted (remember they are only sent to the Trash so if you really want them gone select the
Trashed Status in the drop down and then Empty Trash.



Status

Virtuemart Order Id

Order Number

Usger Id

User Name

Emai

User Realname

User Clty

User Country

Product Name

Unpublished v

testi@giowebdesign.com

Test

Sydney

Australia

Dress

B o | i © e
o] 4
Reminder Mot sent

Order_reviews

Product Image

fmediafordersave/73ldress g

The status of individual reviews can be seen, e.g. if the reminder has been sent, if the client has
submitted a review and if you have published it. You can retrospectively add all your old orders by
using the VM Reviews Importer. You can set the limit of how many to import each run .. the system

will check to see what has been imported so no duplicates will occur.
Since version 2.0.3 there is now an importer for the old VM reviews.

It is to be used entirely at your own risk!
We cannot be responsible for lost data etc and you must backup your site before attempting any import!

VM Reviews Importer

Mezge

Use at your own risk!

2 Joomial

All old orders will be entered in the VM Review component, reminders will sent in batches

dependent on your Zoombie - VMReview plugin settings.

You can also check how many orders are not in the VM Review component.




There is also an importer so all your old reviews and ratings from the native VM component can be
imported.

Previous VM Reviews Importer

Thizt 1ol w mpar the ald VrteeManm Revevs mto the new VMEBEy

read out of the process can be seen, After running

Import Old Reviews

Also you can send a test email to check the appearance of your formatted email configured in the
Zoombie - VMReview plugin.

Step5: What the user sees

After the order has been set to the Status trigger value (normally "C") the user, when he logs into his
account on the site will see an extra section under the "My Account" menu.

My Reviews
Product
Image redus Date Price Status = Rewview
Name
Jumper Sunday, 28 Jun 2015 - 11:52 528405 (] Add review
our review:
Characters written: | 0 Min 100 Charactors
Your rating:
Submit Review
Poncho Sunday, 28 Jun 2015 - 11:52 348.84 (]
Rating :
Your review :
This is a fantastic Ponche - very warm and waterproof -
‘Would recommend to anyone! Great product!

Here they can see their purchase history (per product - not just per order) and add a review.

They can also see their old reviews and their status.



' Santa Cap Saturday, 27 Jun 2015 - 17:05 $24.90 [«] Add review

Your review Y

This is a fantastic Santa hat - very warm and not at all scratchy - \
Would recommend to anyone! Great product] '

Characters written: 109 Min 100 Charactars
Your rating

i i W W & -
N

.

Submy Re'.'iew‘_
%y Reviews l

Once the review has been submitted:

Your review has been saved and wil be moderated.

The moderation settings are in the Virtuemart - VMReview plugin

The user can also check their old reviews:

Default product | Saturday, 27 Jun 2015 - 17:09 550.50 & View J%ur review

Rating :

HHEH NN N
Your review :

This is a fantastic Jumper - very warm and not at all scratchy -
Would recommend to anyone! Great product!




Non Registered Shoppers

If you choose to allow non-registered shoppers then you need to create a menu item to the Reviews

form page.
Menus: Edit ltem 7t Joomlal’
+ | Save & Close 4+  Save & New L1 | Save as Copy @ | Close @  Hep
MenuTitle * | Leave a review Alias | leave-a-review
Details Link Type Page Display Metadata Module Assignment

Menu ltem Type * Leave Review Menu *

Main Menu =
Link index.php?option=com_vmreview&view=orderrevlewsform

Parent ltem

Target Window Parent - Menu ltem Root o
Template Style - Use Default - - Ordering

Leave a review =

These shoppers are still sent reminder emails and can either use the configured menu above or click
on the link in the email that will access them the order and a review form.

If they come directly to the form they must enter their email and order number to access the order:

My Reviews

Enter the email address vou used for vour purchase and vour order number:

Emal address four ander mumiber Submit Emal Order Kumber

“rour email address:
MNo confirmed orders found - please re-enter your email address.




My Reviews

Enter the email address you used for your purchase and your order number:

Emal addrees Yiour onder number Submit Email i Onder Mumber

“rour email address: test7i@gjcwebdesign.com

Product
Image Name Date Status | Review

test 2 WITH

. Thursday, 21 May 2020 - 21:34 €44 50 L] Add review
anyprice @

My Reviews

Enter the email address you used for your purchase and your order number:

Emal addrmes Yiour ander numiber Submit Emal/Onder Mumib=r

“our email address: test¥i@gjcwebdesign.com

Product
Image Name Date Status | Review

test 2 WITH
N Thursday, 21 May 2020 - 21:34 £44.50 o m
anyprice
Your review:
Charactors |0 Min 100 Charactors

Your rating: W % W W W

Submit Review




Public Reviews

If enabled the public can also leave reviews from the product details page:

VM - Category

Laotonttlet becknzcks
T-Snins

Test

WriRing s2t5

Wi - Currencies Selector

Wi - Manufacturer

Leave a Review =t

Amrage Rt WK
Ay

Saksprice ST

Colour

| Choose 3 varniant ¥ |

[Printing

Wttt inting

51437 2t g

Name-
Emall address*
o review
r— a Wiin 100 Craraciors
“Your rafing HHAANN
I'm not a robot Mt
RCAPTCHA
bebvasy-Tarme
Submill Revies
Toial Revlews: 2
Aerage Ratihg
"W
21-05-2020
Winat achually nappenad IS et S0me getalls of e detaul capicha Included In e, and Cursaom o pers Et do not wse 3 cartain menod o Include | in Melr s,
nead 0

Fuead mare




Step6: Reminder Emails
If the Zoombie and Reminder Plugins have been activated the user will receive a reminder email to
leave a review after the set number of days: This can be plain text or html.

Dear testtc,
On the 2018-08-07 13:44:55 you bought our
1: Classic Hat

2: Derby Hat
3: Baseball Cap

If you are satisfied with this product we would be delighted if you would leave a review on our site.

If registered simply login and browse to 'Your Account' where you will be able to submit your review.

If you purchased as a guest then click the link below.
13.8.1 | VM3.2.4 GIC joomla336 - Leave A Review

If you wish to opt out from these reminders then click the link below.
13.8.1 | VM3.2.4 GIC joomla336 - Opt out from these reminders

Yours faithfully,
13.8.1 | VM3.2.4 GIC joomla336

When a user leaves a review the Admin receives an email:

MNew Review : Joomla 3 GIC Test2
0 GIC Virtuemart Beviews ¢

New review received at at 27.06.2015, 17:14:03

PR RN TR R R R R AR R R R R SRR RN RN SRR RERTERER

Rating is: 5

Review reads: This Is a fantastic Santa hat = very warm and not at all scratchy -
Wiould recommend bo anyone! Great product!

Order ID is: 12b606

WM Order Number is: 5

WM Reviews application for Virtwemart by b




Step7: Review display
There are different ways to display the reviews on your site, either through the component, the
relevant reviews on each product page or via the module.

To display via the component simply make a menu to the VM Review Order_reviews view

Tags

Lk, Manager
N4 Figeters
Covopy_reviews

San i'ﬂlan\. a ligt of Qade_reiews

Wirluebiat

Wetilnko

Wrapper

You can also make a menu item to show a single review page.

U=ernam

Paszwol

WM Review WeblinH
Single Drdern'f.rﬂ EWE List AllWA
Order_revie List Web
Show a specific Orderrevlews } Submit &

Wrapper Virtuel
Iframe VWrapper Shopping

In the options of VM Review Component there are settings for the review page.

o %nm

- Select Status -

r Product
ntry Name Rating Reminder Review Date Published ID

mlia Do 0 '] o 01506, 4




Vmreview Configuration

WM Review Permissions

Global Configuration

Component for reviews linked to Virtuemart purchases

Order by Random
How many to show 10
Shiow product name 5 No

Shiow a link on the product name ® No

The page will display so: (all templates can be over-ridden in the template over-rides)

Our Reviews

Rating : 4 4 7 #r %

Review :

This is a fantastic Jumper - very warm and not at all scratchy -
Would recommend to anyone! Great product!

Test

Rating :
Review :
A fantastic dress - very nice!

Test

To display the relevant reviews on each product page enable and configure the vmcustom show
reviews plugin.

| .
# Plugin Manager: VM Custom - Show Reviews Joomial
B oo || 0o B ey
VM Custom - Show Rev
m = Show Reviews: =
| ercuctes B howrmviesn)
W Custom plugin be show e neviess from the GIC Product Risviess comporent In 3 produdt page Arness
Publ
Do
1 WM Curstom - Customes te
Y L
F T
Ol Randdar 1
P
Nt
Shiow am

Manually inserting the template over rides

You also need to ftp the default_gjcshowreviews.php & default_gjcshowreviewform.php template to
your template over rides if you haven't already done this. This file is in the folder
virtuemart_template_over_rides_VM3 zip that you initially unpacked.

The path will be
templates/YOUR_TEMPLATE/html/com_virtuemart/productdetails/default_gjcshowreviewform.php

&

templates/YOUR_TEMPLATE/html/com_virtuemart/productdetails/default_gjcshowreviews.php



You then just need to add the following code snippet in your
templates/YOUR_TEMPLATE/html/com_virtuemart/productdetails/default.php where you want the
reviews to show up.

Normally this would be where the current VM call to it's native reviews template is.
e.g. add the red code - the green is normally already there.

//GJC Reviews - here the extra templates are loaded
echo $this->loadTemplate ('gjcshowreviewform');
echo $this->loadTemplate ('gjcshowreviews');

//GJC Reviews

//echo $this->loadTemplate ('reviews');

Ratings display
Again just replace your current code with:

//GJC Ratings
echo $this->loadTemplate ('gjcshowrating');
//GJC Ratings

Similarly in any module or in the sublayout products.php for the category view of products just add
this snippet at the start of the module template over ride to include the plugin - so at the top of the
php file

//GJcC

Slanguage = JFactory::getLanguage () ;
$language->load('plg vmcustom showreviews', JPATH PLUGINS . DS
'vmcustom' .DS . 'showreviews');

Splugin2 = JPluginHelper::getPlugin('system', 'vmreview');//this is
the system plugin

Sparamsgjc2 = new JRegistry($plugin2->params) ;

Smaxrating = S$paramsgjc2->get ('maxrating', false);

//GJcC

@
g

£language = JFactory::getLanguage():
31anguage_plgad(‘;;;_"x:;a-'x showrevi JPATH PLUGINS . DS . 'vmcustom' .D5 . 'showreviews'):

, 'vmreview');//this is the system plugin

S£plugin2 = JPluginHelper::getPlugin(

fparamsgjc2 = new JRegistry($plugin2->params);
Emaxrating = Sparamsgjc2->get('maxrating', false):
31 P Achi e
foreach ($viewData['products'] as Stype => Sproducts )} {

and where the stars display comment out the existing ratings code:
// comment out any existing rating code
//echo

shopFunctionsF: :renderVmSubLayout ('rating',array ('showRating'=>S$Sshow
Rating, 'product'=>S$product));

and paste:

//GJC



if(!class exists('vmCustomPlugin'))
require (JPATH VM PLUGINS.DS.'vmcustomplugin.php');

JPluginHelper: :importPlugin ('vmcustom') ; Sdispatcher =
JDispatcher::getInstance();

Sreviews = S$dispatcher-
>trigger ('plgVmShowreviews',array (Sproduct->virtuemart product id,
$product->product parent id));

Saverage = Sreviews[0] ['average'];
if (!Saverage) {$average = 0;}

2>
<span class="vote gjc">

<span id="plgstarrrmsingle<?php echo S$product-
>virtuemart product id; ?>" class="starrs"></span>

</span>

<?php

echo "<script
type="'text/javascript'>jQuery (document) .ready (function () {JjQuery ('#pl
gstarrrmsingle".$product->virtuemart product id."').raty({ path:

'" JURTI::root () ."plugins/system/vmreview/assets/js/img/"',number:
".Smaxrating.", readOnly: true,score: ".S$Saverage." });});</script>";

//GJC

vm-product-rating-container">

ho shopFunctionsF::renderVmSubLayout ('rating',array('showRating'=>$showRating, 'product'=>S$product));

if (!class_exists ('vmCustonPlugin')) require (JPATH VM PLUGINS.DS.'vmcustomplugin.php'):
tcher = JDispatcher::getInstance();

ews',array ($product->virtuemart_product_id, $product->product_parent_id)):

JPluginHelper: : importPlugin
$reviews = Sdispatcher—>tri

Saverage = Sreviews[0] ['av
if (!Saverage) {Saverage = 0;}

94 [ <span class="vote_gio">
<span id="plgstarrrmsingle<?php echo Sproduct->virtuemart_ product_id; 2>" class="starrs"></span>

<fspan>

<?php echo "<scrip

$product->
wirtuemart product id TRilug i

".JURI: :root () ."p ", Smaxrating.”,

Saverage.” 1):}):

if ( VmConfig::get ('display tock', 1)) { 2>
php echo $product->stock->»stock level ?>" title="<?php echo $product->»stock->stock_tip ?>"></span>

<span class="vmicon vm2
<?php }
echo shopFunctionsF::renderVmSubLayout ('stockhandle',array ('product'=>$product));

</divs

User override

You also need to ftp the edit.php & edit_reviews.php template to your template over rides if you
haven't already done this. This file is in the folder virtuemart_template_over_rides VM3 zip that you
initially unpacked.

The path will be templates/YOUR_TEMPLATE/html/com_virtuemart/user/edit.php
&
templates/YOUR_TEMPLATE/html/com_virtuemart/user/edit_reviews.php

If you prefer to adjust the edit.php manually then add the red code - the green is normally already
there.



Mame 5ize | Changed

A.
H edit.php AKB  09/02/2021 13:10:05
edit_address.php

edit_address_userfields.php

» edit_address_addshipto.php
]

edit_reviews.php

if (lempty (Sthis->shipto)) {
Stabarray['shipto'] =
'COM VIRTUEMART USER FORM ADD SHIPTO LBL';
}
if (($ _ordecnt = count ($this->orderlist)) > 0) {
Stabarray|['orderlist'] = 'COM_VIRTUEMART YOUR ORDERS';
}
//GJC Reviews - here the extra tab is loaded
if (($_ordent = count(Sthis->orderlist)) > 0) {
Stabarray|['reviews'] = 'PLG_VMREVIEWS TITLE';
}
//GJC Reviews

68 ff5tabarray['user'] = "COM VIRTUEMRRT USER FORM TRE GEMERRLINFO';
&9 = if {lempty($this-*shipto)) |
T $tabarray['shipto’'] = "COM VIRTUEMRRT USER FORM RDD SHIPTO LEL';
T2 = if {{% ordcnt = count(jfthis->orderlist)) > 0} {
T3 ftabarray['orderlist’'] = "COM VIRTUEMRRT ¥YOUR ORDERS'
na 2 1
75 = if {{% ordcnt = count(jfthis->orderlist)) > [} {
TE $tabarray['reviews'] = "PLE VHMREVIEWS TITLE';
77 !
7 shopFunctionsF: :buildTaks ( $this, %tabarray);
21 } elzse |
52 echo 3this-*loadTemplate { 'shopper' );
3 -1
= { captcha addition




Styling

Any styling you need can be done in the provided css file :
plugins/vmcustom/showreviews/assets/plgvmreviews.css

Total Reviews: 4
Awerage Rating:

5 Star ! W 2
4 Star " 1]
3 Star o 4 i

18.12.2015

This really is a great hat ., fantastic Recommend to amyone with 3 cold head.. And the colowr is fantastic
Fired
Represa - United States

Was this review helpful to you? | Mo || “es 5 wsers found this halpful

18-12-2015

Virueban handies 4 modes for the vendorld of the cart, the vendor is set always to the mainvendor (with

id=1) by the first product logged in vendor (agent) selectable by shopper [shopper...

Fred Resd mone
Repress - United States

Was this review helpful to you? | Mo || es 1 wser found this helpful.

16-12-2015

Just to update you regarding this matter. | have now opened a suppart request with Micrasaft regarding this
domain namafisswee and will ket you know ifiwhen we receive any further valusble...

Fred Fesd rone
Reprzza - United States

Was this review helpful to you? | Mo || es

5ee all 4 customer reviews

Visitors can rate the reviews as "helpful" or not and the reviews will be displayed in this order.
i.e first by stars and then by "helpfulness"

The reviews can also be displayed by their star rating
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Average Rating: ¥ # &
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Manufacturer : Froducer VM - Search in Shop
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2 Star e v F Write 3 review
1 Star 4 1
W W W W
18-12:2015 VM - Category
This realhy is a great hat .. fantastic Recommend to anyone with 3 cold head. . And the colowr is fantastic Diefzult Pattern
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' T EE RS Clothing L
16-12-2015
VirtueMart handles 4 modes for the vendorld of the cart, the vendor is set always to the mainvendor {with
id=1) by the first product logged in vendor {agent) selectable by shopper {shoppsr. ..
Repress - United States Resd more )
Main Menu
Was this review helpful to you? Mo “es  f wser found this halpful Home
contact vendor
Cart
See all 4 customer reviews My Account
Gastenbosk
“fou are here:  Home
Another example of what is possible with a little effort is shown below.
Recensioni clienti Ritorna a Piatti Doraemon
Condividi! I tua opnons zon sitn clentl. Acguists Platti Doraemon e scavi uns recensions
pa nedi
e B Articolo Piatti Dorsemaon

Voto medio:

5 Star e e Je e k1 Produttore  Luk Intemacional
4 St W A K 0

ISt Kk K 1 Prezzo

2Sta o K 0

1St W 0

Legg! tutte le 2 recension dei nosts chents b

7 g utenti hanno trovato queata utile

% % ok % %k

& Veronica ds Amelia 2 05 giugno 2018

Acquisto vermicate

Prodotio come da descrzione & moito valido, moito soddisfatta anche per la velocta dei temp: di consegna.

NOY

Questa recensione 1 ¢ stata wie? €7 S NO

4 gf wtenti hanno trovato questa ufife

* % %

& Delia da Sari # 05 gugno 2018

Acquisto vermicato

Pigtti di carta simili a quelli di tanti altri personagg, ma Dotsemon non i trova in gro. | oolor sono molto beli ma | pez2i nettamente pochi rispetio al
prezzo.

Questa recensons U & stats utie? ('_‘; S| I NO




There is also a highly configurable VMReviews module included that can display the reviews in many
different ways. Number of reviews, filter by Manufacturer, Category, what to display etc etc

W Module Manager: Module VMReview Joormial
B - oo || 4 smsne N Save asCogy || O Oose 0 re
Tt Our Reviews
Show Tide
VMREview
i2e
dodule - Fa CONTHpICHT = EEpition
Righit [fesition-7
r—
e, R0 Show
it Pubdl
o ek g
o Image . h Pt
d =
Shiowy calegony ; ATiE
Pub

[r=] RAddiolCart Our Reviews

Total Reviews: 2
Average Rating:

Ask a question about this product
Santa Cap
Default
Manufacturer: Default
. sed diam nonumy eirmod tempor invidunt ut labore et dolore
accusam et justo duo dolores et ea rebum. Stet clita kasd .
R . This is a fantastic
olor sit amet. Lorem ipsum dolor sit amet, consetetur sadipscing " Forr o
et dolore magna aliquyam erat, sed diam voluptua. At vero eos et anta hat - very

bsd gubergren, no sea takimata sanctus est Lorem ipsum dolor sit juarmiandiosatall
scratchy - Would

recommend to anyone! Great
product!

test1

Sydney - Australia

Default product

This plugin is a little more complex than some to install and configure and if you need any help we
are always here. Just contact us by the http://www.gjcwebdesign.com/home/support.html page.

You can always read some of the reviews on Joomla Extensions to see what other customers think of

our service!
http://extensions.joomla.org/extensions/extension/extension-specific/virtuemart-

extensions/product-review-for-virtuemart
e.g

"Bought this extension because the default review system that
comes with VM is far from perfect. This extension works
excellent straight out of the box! It is nicely configurable through
CSS to create your wanted look and feel. After a few questions
concerning functionality to the support department, we got

'EBDESIGN
answers and solutions in a matter of hours. Thank you John, a L Il

job well done!



http://www.gjcwebdesign.com/home/support.html
http://extensions.joomla.org/extensions/extension/extension-specific/virtuemart-extensions/product-review-for-virtuemart
http://extensions.joomla.org/extensions/extension/extension-specific/virtuemart-extensions/product-review-for-virtuemart

Change Log

30.08.2018 v2.0.12

Added: Translated product names

Added: German, Italian, Latvian and Russian languages
Minor: css fixes

30.08.2018 v2.0.11
Added: Option to show siblings reviews on child

11.05.2017 v2.0.10
Added: Direction choice by Date in Reviews Component
Added: inclusion of Zoombie and CLI plugins in package

02.02.2017 v2.0.9
Fix: default_gjcshowreviews.php tidied

17.12.2016v2.0.8
Added: Direction choice by Date in Reviews Component

Added: Date display in overall Reviews Display

Added: VM sublayout example for Rating Stars on Category View
Added: Direction choice by Date in Productdetails VM view
Changed: css widths of overall Reviews Display

Fixed: Translations of "Stars" on Productdetails VM view

Fixed: Average rating display on Productdetails VM view

20.11.2016 v2.0.7
Fixed: Show date on Productdetails VM view

Fixed: pagination fix for filtered reviews
Fixed: router fix for no product id

20.05.2020v2.1.00
Updated: Unregistered and public able to leave reviews

Updated: Native Joomla ajax methods used for submission
Updated: Joomla Captcha incorporated

20.05.2020v2.1.1
Updated: Recipients can opt out from reminders

Fixed: only orders with reviews shown @ index.php?option=com_vmreview&view=orderrevlewss
Fixed: average rating on product detail view

Fixed: reminders only sent to published orders






